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This application note primarily shows how the Magic Object is used to
implement a ViSi-Genie project that allows the host to access files on the
uSD card of the display. There are seven types of file access operations:

MFILE_READ
MFILE_WRITE
MFILE_APPEND
MFILE_ERASE

MFILE_DIR
MFILE_SCREEN_CAPTURE
MFILE_SIZE

No vk wnNe

For this application note, the file access operation “MFILE_SIZE” is
discussed. The implementation of a file size request operation further
requires the use of the following 4DGL features and functions in
combination with the Magic Object:

e String class functions
e FAT16 file functions
e seroutCs(...)

The String class functions and FAT16 file functions are functions native to
the Picaso and Diablo16 processors.

The function seroutCS(...) is one of the Genie Magic callable functions in the
ViSi-Genie Communications Protocol. This function writes a parameter to
the Genie Serial port and updates the output checksum.

Below is a screenshot image of the project used in this application note.

File access sample.
Demonstrate this
using the 'Magic File
Object’ interface in
the 'send values'

button for the Magic
Object in GTX

Refer to the ViSi Genie Reference
manual for information about the
‘protocol

Note 1: The ViSi-Genie project for this application note is the demo
“FileAccess”, which is found in Workshop. Go to the File menu -> Samples -
> ViSi Genie Magic (Picaso/Diablo16) -> FileAccess.4DGenie.
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Note 2: Workshop Pro is needed for this application.

Before getting started, the following are required:
e Any of the following 4D Picaso and gen4 Picaso display modules:

gend-ulLCD-24PT
uLCD-24PTU

gen4-ulLCD-28PT gen4-uLCD-32PT
uLCD-32PTU uVGA-III

and other superseded modules which support the ViSi Genie
environment

e The target module can also be a Diablo16 display

gend-ulLCD-24D series gen4-ulLCD-28D series gen4-uLCD-32D series

gen4-ulLCD-35D series gen4-ulLCD-43D series gen4-uLCD-50D series

gen4-uLCD-70D series
uLCD-35DT

uLCD-43D series uLCD-70DT

Visit www.4dsystems.com.au/products to see the latest display

module products that use the Diablo1l6 processor. The display
module used in this application note is the uLCD-32PTU, which is a
Picaso display. This application note is applicable to Diablo16 display

modules as well.

e 4D Programming Cable / uUSB-PA5/uUSB-PA5-II
for non-gen4 displays(uLCD-xxx)

e 4D Programming Cable & gen4-PA, / gen4-1B / 4D-UPA
for gen4 displays (gen4-uLCD-xxx)

e micro-SD (uSD) memory card

Workshop 4 IDE (installed according to the installation document)

When downloading an application note, a list of recommended
application notes is shown. It is assumed that the user has read or
has a working knowledge of the topics presented in these
recommended application notes.

Page 3 of 18

www.4dsystems.com.au


https://www.4dsystems.com.au/product/gen4_uLCD_24PT/
https://www.4dsystems.com.au/product/gen4_uLCD_28PT/
https://www.4dsystems.com.au/product/gen4_uLCD_32PT/
http://www.4dsystems.com.au/product/1/7/4D_Intelligent_Display_Modules/uLCD_24PTU/
http://www.4dsystems.com.au/product/1/9/4D_Intelligent_Display_Modules/uLCD_32PTU/
http://www.4dsystems.com.au/product/1/124/4D_Intelligent_Display_Modules/uVGA_III/
https://www.4dsystems.com.au/product/gen4-uLCD-24D/
https://www.4dsystems.com.au/product/gen4-uLCD-28D/
https://www.4dsystems.com.au/product/gen4-uLCD-32D/
https://www.4dsystems.com.au/product/gen4-uLCD-35D/
https://www.4dsystems.com.au/product/gen4-uLCD-43D/
https://www.4dsystems.com.au/product/gen4-uLCD-50D/
https://www.4dsystems.com.au/product/gen4-uLCD-70D/
http://www.4dsystems.com.au/product/uLCD_35DT/
http://www.4dsystems.com.au/product/uLCD_43D/
http://www.4dsystems.com.au/product/uLCD_70DT/
http://www.4dsystems.com.au/products
http://www.4dsystems.com.au/product/17/114/Accessories/4D-Programming-Cable/
https://www.4dsystems.com.au/product/uUSB-PA5/
http://www.4dsystems.com.au/product/17/114/Accessories/4D-Programming-Cable/
https://www.4dsystems.com.au/product/gen4_PA/
https://www.4dsystems.com.au/productpages/gen4-IB/downloads/gen4-IB_datasheet_R_1_2.pdf
https://www.4dsystems.com.au/product/4D_UPA/
https://www.4dsystems.com.au/product/uSD_4GB_Industrial/
http://www.4dsystems.com.au/product/10/120/Development/4D_Workshop_4_IDE/

APPLICATION NOTES 4D-AN-00165

Is cmd Equal to “MFILE_SIZE”? 12
Description 2 Diagram C. File Size Request Operation (Detailed) 12
Content 4 Open the File 12
Application Overview 5 Check for Error 13
Setup Procedure > Get the File Size 13
Create a New Project 5 Close the File Size 13
Create a New Project 5 Send the File Size to the Serial Port 13
Design the Project > Build and Upload the Project 13
Add Two Static Text Objects to FormO 5 Identify the Messages 14
Add a Magic Object to FormO 6 Use the GTX Tool to Analyse the Messages 14
Model 6 Launch the GTX Tool 14
General Model 6 File Size Request 15
File Size Request 7 WRITE_MAGIC_BYTES Message 15
WRITE_MAGIC_BYTES 7 REPORT_MAGIC_EVENT_BYTES Message 16
REPORT_MAGIC_EVENT_BYTES 9 File Error 17
File Error ? Acknowledgment Byte 17
The Magic Object 10 Proprietary Information 18
([;ibajgezlm A. Implementation of the General Model Using a Magic.:u Disclaimer of Warranties & Limitation of Liability 18

Diagram B. File Size Request Only Using a Magic Object 11

Is the Message a WRITE_MAGIC_BYTES Message? 11

Parse the Array for the Filename 11

Start Constructing the REPORT_MAGIC_EVENT_BYTES Messagel2

Page 4 of 18 www.4dsystems.com.au



APPLICATION NOTES

4D-AN-00165

Application Overview

In the past it was not possible for a host to access files stored on the uSD
card of a display module loaded with a ViSi-Genie application. With
Workshop 4 Pro it is now possible to accomplish this through the use of the
Magic Object. The Magic Object is one of the objects available under the
Genie Magic pane. It is actually a 4DGL function which allows users to
program the display to handle bytes received from an external host. The
user, for instance, can create a Magic Object that waits for a certain
sequence of bytes coming from the host. The sequence can contain an
instruction byte (e.g. a file size request) and a null-terminated 8.3 format
filename (e.g. "datalogl.txt"). Upon receiving this the display module will
get the size of the file and send it back to the host. The ViSi-Genie example
project “FileAccess.4DGenie” is an implementation of the above
application.

Setup Procedure

For instructions on how to launch Workshop 4, how to open a ViSi-Genie
project, and how to change the target display, kindly refer to the section
“Setup Procedure” of the application note:

ViSi Genie Getting Started — First Project for Picaso Displays (for Picaso)

or
ViSi Genie Getting Started — First Project for Diablo16 Displays (for
Diablo16).

Create a New Project

Create a New Project

For instructions on how to create a new ViSi-Genie project, please refer to
the section “Create a New Project” of the application note

ViSi Genie Getting Started — First Project for Picaso Displays (for Picaso)

or
ViSi Genie Getting Started — First Project for Diablo16 Displays (for
Diablo16)

Design the Project

Add Two Static Text Objects to FormO

Two static text objects are added to FormO. These are Statictext0 and
Statictextl.
File access sample.

- Object Inspect 53
Demonstrate this bject Inspector
using the 'Magic File Form | Form0 v
L2 ;

Ob]?ct mterface: in | Object | statictexto v
the 'send values
button for the Magic
Object in GTX

Object Inspector B2

Farm | Formao LY
Refer to the ViSi Genie Reference . .
manual for information about the [ Object | Statictextl ¥

'protocol
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To know more about static text objects, their properties, and how they are
added to a project, refer to the application note

ViSi-Genie Labels, Text, and Strings

Add a Magic Object to FormQ
A Magic Object is added to Form0. This is MagicObject0.

Dbject Inspector 3
Form | Forma W
Object | MagicObjectd (File access) W

Properties | Events

Property Value

Mame MagicObjectd
Alias File access

Code MagicObjectD.inc

To know more about Magic Objects, their properties, and how they are
added to a project, refer to the application note

ViSi-Genie How to Add Magic Objects

Model

General Model
Below is a general model for an application that performs file access
operations.

The host sends a WRITE_MAGIC_BYTES
message containing a command byte,
the filename, and data (if needed). The

command byte dictates the file
° operation to be performed.
L \
V) .
Display
! Module

° The display module sends data
The display

back to the host if necessary in the form
of a REPORT_MAGIC_EVENT_BYTES module evaluates the

message. The display module then sends

Host

command byte and
an acknowledgment (ACK). performs the requested

file operation.

The WRITE_MAGIC_BYTES and REPORT_MAGIC_EVENT_BYTES messages
or commands are two complementary messages that are used in ViSi-Genie
Magic. The host sends a WRITE_MAGIC_BYTES message, and the display
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module, after performing the requested operation, replies with a
REPORT_MAGIC_EVENT_BYTES message. Steps2 and 3  can be
implemented using a Magic Object.

File Size Request
Below is a model specific to an application that performs a file size request

operation.

Host

The host sends a WRITE_MAGIC_BYTES
message containing the function code or
command byte “MFILE_SIZE” and the name

of the file whose size is being requested for.
(U e \
v) .
Display
! Module

°The display module then sends a ° After checking

REPORT_MAGIC_EVENT_BYTES message that the command byte
back to the host. If the operation was is  “MFILE_SIZE”, the

display

successful, this message will contain the module

size of the file. Otherwise it will contain only acquires the size of the
the function code “MFILE SIZE”. Finally, the file.
display module sends an acknowledgment

(ACK).

Section 5.4 (Genie Magic File Access object) of the ViSi-Genie Reference
Manual documents the seven file operations implemented in the example
project “FileAccess.ADGenie”. For this application note, will take look at
MFILE_SIZE.

WRITE_MAGIC_BYTES

The standard format of WRITE_MAGIC_BYTES message, as defined in
section 2.1.2 (Command and Parameters Table) of the ViSi-Genie Reference
Manual is:

Command Code Para- Para- Para- Para- Para- Checksum
meterl meter2 meter3 meter4 meterN

WRITE_ 0x08  Object Length Array (1 byte values) Checksum
MAGIC_ Index
BYTES

The section “2.1.3.8 Write Magic Bytes” further says:

\ Description

This command can be used to send an array of bytes to a magic object.
The magic object can process the bytes in any way you want it to as there
is no restrictions on the format of the information sent.

Notel: The maximum number of bytes that can be sent at once is set by
the ‘Maximum String Length’ setting in Workshop under File, Options,

Genie.

Note2: A Workshop PRO license is required to use this capability.
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Section 5.4 (Genie Magic File Access object) of the ViSi-Genie Reference
Manual describes the WRITE_MAGIC_BYTES message for a file size request
operation (as expected by FileAcces.4DGenie).

Function Byte Description and Parameters
Value notes
MFILE_SIZE 6 Report the size of Function code, Null, or 4
a file Filename bytes

Response

Thus, a WRITE_MAGIC_BYTES message specific to a file size request
operation, has the format:

Command Code Para- Para- Para- Para- Para- Checksum
meterl meter2 meter3 meter4 meterN

WRITE_ 0x08  Object Length function code + filename Checksum

MAGIC_ Index

BYTES

To request for the size of the file “FILEAC~1.gci”, the host would send:

[0 00 OE 06 46 49 4C 45 41 43 T7E 31 2E &7 &3 &% 00 0B8]

Command Code Para- Para- Para- Para- Para- Checksum
meterl meter2 meter3 meter4 meterN

WRITE_ 0x08  Object Length function code + filename Checksum

MAGIC_ Index

BYTES
[T | ¥

[08 00 OE 0O& 46 49 4C 45 41 43 7E 21 2ZE &7 63 6% 00 08]

T y ]

MFILE_SIZE FILEAC~1.gci null
terminator
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REPORT_MAGIC_EVENT_BYTES
The standard format of a REPORT_MAGIC_EVENT_BYTES message, as Command Code Para- Para- Para- Para- Para- Checksum
defined in section 2.1.2 (Command and Parameters Table) of the ViSi-Genie meter1 meter2 meter3 meterd meterN
L REPORT_  O0xOA  Object Length Array (1 byte values) Checksum
Reference Manual is: MAGIC_ Index
EVENT_
Command Code Para- Para- Para- Para- Para- Checksum BYTES
meterl meter2 meter3 meter4 meterN
REPORT_  OxOA  Object Length Array (1 byte values) Checksum
MAGIC_ Index A l
EVENT_ { \
BYTES |[|:|A 00 05 06 OO O1 CO OO CE8] |
Section 5.4 (Genie Magic File Access object) of the ViSi-Genie Reference |
Manual states that a REPORT_MAGIC_EVENT_BYTES message for a file size MFILE_SIZE
request operation, as implemented in FileAcces.4DGenie, will have the o
following additional data. File size = 0x0001C000 (bytes)
Command(s) Type Notes \
Size Function code MFILE_SIZE
‘Null Only the ‘function code’ will be sent if File Error
an error occurs (eg file does not exist) If an error occurs during the operation, an empty or null
4 Bytes File size big Endian (i.e. most significant

byte first)

Below is an example of a REPORT_MAGIC_EVENT_BYTES message for a
successful file size request operation.

REPORT_MAGIC_EVENT_BYTES message is sent back by the display module.
The message will contain only the command byte for file size request.
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The Magic Object

Going back to our working model for a file size request operation, the host
would need to send a WRITE_MAGIC_BYTES message to the display module
(step 1). The display module then acquires the file size (step 2) and sends
back a REPORT_MAGIC_EVENT_BYTES message, along with an ACK byte
(step 3).

We have also seen that the demo “FileAccess.4DGenie” expects the host to
follow a certain format for a WRITE_MAGIC_BYTES message. The demo
“FileAccess.4DGenie” also follows a certain format when it constructs a
REPORT_MAGIC_EVENT_BYTES message to be sent back to the host. These
formats are in addition to the standard formats of WRITE_MAGIC_BYTES
and REPORT_MAGIC_EVENT_BYTES messages described in the ViSi-Genie
Reference Manual.

The demo “FileAccess.4DGenie” uses a Magic Object to receive and handle
WRITE_MAGIC_BYTES messages, to perform the requested operation, and
to send REPORT_MAGIC_EVENT_BYTES messages.

The prototype of the 4DGL function inside a Magic Object is:
rMagicObjectO(var action, var object, var newVal, var *ptr);

Since this function will be used to receive and handle the

WRITE_MAGIC_BYTES message coming from the host, it is expected that the

passed parameters will give the wuser access to the received
WRITE_MAGIC_BYTES message. Below are the descriptions of the

parameters, as per the section “5.1 Genie Magic callable Functions” of the
ViSi-Genie Reference Manual.

action The command that was received from the host, one of
1. READ OB,
2. WRITE_OBJ,

3. WRITE_MAGIC_BYTES or
4. WRITE_MAGIC_DBYTES
object Normally the object received from the host will be the
same as the n in the function name, but since you could
call this function internally it might be something else.
newVal N/A for Action of READ_OBJ, New value for Action of
WRITE_OBJ, Otherwise number of parameters in the ptr
array.
ptr N/A for Action of READ_OBJ and WRITE_OBJ, otherwise
Pointer to array of parameters passed. Array is always a
standard Picaso/Diablo integer array. For
WRITE_MAGIC_BYTES each element contains a byte.

For the example project “FileAccess.4DGenie”, the parameter “action” is
WRITE_MAGIC_BYTES. The parameter “object” is MagicObject0. The
parameter “newVal” is the length of the array or the combined length of the
command byte and the filename string. The parameter “ptr” is a pointer to
the array which will contain the data from the host.
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WRITE_ 0x08  Object Length Array (1 byte values) Checksum
MAGIC_ Index
BYTES

!

rMagicObjectO(var action, var object, var newVal, var *ptr);

Diagram A. Implementation of the General Model Using a Magic
Object

Attached is the PDF file “programFlow.pdf”. It contains three diagrams, the
first of which illustrates the implementation of the general model. This
diagram represents the example project “FileAccess.ADGenie”. The area
bounded by the broken lines is implemented using a Magic Object.

Diagram B. File Size Request Only Using a Magic Object

The second diagram of the PDF file “programFlow.pdf” represents the scope
of this application note — the file size request operation.

Is the Message a WRITE_MAGIC_BYTES Message?
if (action == WRI TE MAGIC EBYTES)

Parse the Array for the Filename

The array pointed to by ptr is an array composed of 16-bit elements. The
filename is to be extracted from this array. In 4DGL, characters can be stored
as 16-bit elements in an array (word-aligned) or as a string (byte-aligned).
The string class functions apply only to strings. To illustrate using the
filename “ascii.txt”:

16-bit element array

address ptr[1] ptr[2] ptr[3] ptr[4] ptr[5]
0x0061 0x0073 0x0063 0x0069 0x0069
a S C i i

ptr[6] ptr[7] ptr[8] ptr[9] ptr[10]
O0x002E 0x0074 0x0078 O0x0074 0x0000
t X t null

4DGL string

Ox7361 0x6963 O0x2E69 0x7874 0x0074
sa ic i xt nullt

Note the difference in endianness and manner of storage. The message
received from the host is stored in the array pointed to by ptr. This array is
internal to Genie and is word-aligned. Since the demo “FileAccess.4DGenie”
uses string class functions to operate on the filename, there is therefore a
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need to convert the 16-bit element array containing the filename to a 4DGL
string. Hence the routine

< newval; i++4)

(ptr[j]

The 4DGL string class operations can now be used to operate on or
manipulate the filename converted as a 4DGL string. Prior to this however,
a string pointer to the filename must be defined.

fname := str_ Ptr(aptrl

For more information on 4DGL strings, please refer to the Picaso or Diablo16

Internal Functions Reference Manual. Right-click on a string class function
name text and choose “Context Sensitive help” to open the manual. Also,
the application note below discusses strings in 4DGL.

Designer or ViSi String Class Function

Start Constructing the REPORT_MAGIC_EVENT_BYTES Message

To know more about the function “seroutCS(...)”,see section 5.1 Genie
Magic callable Functions of the ViSi-Genie Reference Manual.

Extract the Command Byte

Is cmd Equal to “MFILE_SIZE”?

switch (cmd)

case MFILE SIZE

Diagram C. File Size Request Operation (Detailed)

The third diagram of the PDF file “programFlow.pdf” presents a more
detailed view of the file size request operation.

Open the File

myhndl

The function “file_Open(...)" is one of the several FAT16 file functions in
4DGL. FAT16 file functions are used mainly for accessing and modifying files
on a FAT16-formatted uSD card. For more information on the FAT16 file
functions, please refer to the Picaso or Diablol6 Internal Functions
Reference Manual. Right-click on a FAT16 file function name text and choose
“Context Sensitive help” to open the manual.
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Check for Error

if (!myhndl)

r

md)

Get the File Size

e (myhndl, &szh, &szl) ;

r

The functions “file_Size (...)” and “file_Close(...)” are examples of string
class functions in 4DGL. These functions are used mainly for evaluating and
manipulating strings. For more information on the FAT16 file functions,
please refer to the Picaso or Diablo16 Internal Functions Reference Manual.
Right-click on a FAT16 file function name text and choose “Context Sensitive

help” to open the manual.

Note that the size of a file is a 32-bit integer value.

Build and Upload the Project

For instructions on how to build and upload a ViSi-Genie project to the
target display, please refer to the section “Build and Upload the Project” of
the application note

ViSi Genie Getting Started — First Project for Picaso Displays (for Picaso)

or
ViSi Genie Getting Started — First Project for Diablo16 Displays (for
Diablo16).

The uLCD-32PTU and/or the uLCD-35DT display modules are commonly
used as examples, but the procedure is the same for other displays.
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|dentify the Messages The Genie Test eXecutor window appears.

The display module is going to send and receive messages to and from an

. . . . Genie Test eXecutor
external host. This section explains to the user how to interpret these = —
messages. An understanding of this section is necessary for users who Port: COM 3 [[]Reset on open 7 % | Contrast
intend to interface the display to a host. The ViSi Genie Reference Manual is Active Form

-

recommended for advanced users.

Use the GTX Tool to Analyse the Messages

Using the GTX or Genie Test eXecutor tool is one option to get the messages
sent by the display to the host. Here the PC will be the host. The GTX tool is
a part of the Workshop 4 IDE. It allows the user to receive, observe, and send
messages from and to the display module. It is an essential debugging tool.

Launch the GTX Tool

Under the Tools menu click on the GTX tool button.

Home View Tools  Comms  Project

&, Boot uSD [2] Terminal 9600
ﬁ PmmC Loader [Z]Terminal 115200
% RMPet

40GL GTX '

uVGA Link

ey

Magic Objects
Query
o =
Set

Send Values
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File Size Request

WRITE_MAGIC_BYTES Message
Send the MFILE_SIZE command and the filename in a WRITE_MAGIC_BYTES

message.

Contr
Port: COM 3 [ |Reset on open ‘dt_)iscormct| |?r =
Active Form
Magic Objects

o
ET=

Magic Object Interface

() "Other™ (@) Magic File Object

Magic Object Interface
() Other™ (®) Magic File Object

B — 4.}

File Append
File Dir

(K File Erase
File Read

Magic Object Interface
() "Other™

(®) Magic File Object
v | Filename: |FILEAC~1.gd *

Note: “FILEAC~1.gci” is the filename of the generated graphics file for the
Workshop example project “FileAccess.4DGenie”. When you build this
project, Workshop generates the supporting files and their 8.3 format-

Action: |F|IE Size

[ o |

filenames and copies them to the uSD card. FILEAC~1.gci is one of these files.
If the name of the project is different or was changed, replace
“FILEAC~1.gci” with the correct or another filename. Make sure that the file
exists on the uSD card.
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The GTX tool sends the WRITE_MAGIC_BYTES message.

Set MagicObject byte Value 15:00:43_453

[08 00 OE 0O& 46 49 4C 45 41 43 7E 31 2ZE &7 &3 &% 00 08]

The format of this message is:

Command Code Para- Para- Para- Para- Para- Checksum
meterl meter2 meter3 meter4 meterN

WRITE_ 0x08  Object Length function code + filename Checksum

MAGIC_ Index

BYTES
‘ l |
( | v

[08 00 OE 0O& 46 49 4C 45 41 43 7E 31 2E &7 &3 &5 00 08]

T y ]

MFILE_SIZE FILEAC~1.gci null
terminator

REPORT_MAGIC_EVENT_BYTES Message
The display module replies with a REPORT_MAGIC_EVENT_BYTES message
containing the 32-bit file size.

|Magic Object Change Bytes 15:00:43.538

|[III}'L oo 05 06 00 01 CO 0O CE]

The format of this message is:

Command Code Para- Para- Para- Para- Para- Checksum
meterl meter2 meter3 meter4 meterN

REPORT_  Ox0A  Object Length Array (1 byte values) Checksum

MAGIC_ Index

EVENT_

BYTES

{ : \ !

(02 oo 05 06 oo 01 Co oo cCg] |

MFILE_SIZE I

File size = 0x0001C000 (bytes)
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File Error
If the file were not present on the uSD card, the display module would return

a REPORT_MAGIC_EVENT_BYTES message that contains only the function code
“MFILE_SIZE".

Magic Object Change Bytes 16:20:26.231 [0& 0D 01 06 DD]|

Acknowledgment Byte
Either way the display module replies with an acknowledgement byte.

ACK 11:13:21.877 [0D&]

Page 17 of 18 www.4dsystems.com.au



APPLICATION NOTES 4D-AN-00165

Proprietary Information

The information contained in this document is the property of 4D Systems Pty. Ltd. and may be the subject of patents pending or granted, and must not be

copied or disclosed without prior written permission.

4D Systems endeavours to ensure that the information in this document is correct and fairly stated but does not accept liability for any error or omission. The
development of 4D Systems products and services is continuous and published information may not be up to date. It is important to check the current position
with 4D Systems.

All trademarks belong to their respective owners and are recognised and acknowledged.

Disclaimer of Warranties & Limitation of Liability

4D Systems makes no warranty, either expresses or implied with respect to any product, and specifically disclaims all other warranties, including, without
limitation, warranties for merchantability, non-infringement and fitness for any particular purpose.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates.
It is your responsibility to ensure that your application meets with your specifications.

In no event shall 4D Systems be liable to the buyer or to any third party for any indirect, incidental, special, consequential, punitive or exemplary damages
(including without limitation lost profits, lost savings, or loss of business opportunity) arising out of or relating to any product or service provided or to be
provided by 4D Systems, or the use or inability to use the same, even if 4D Systems has been advised of the possibility of such damages.

4D Systems products are not fault tolerant nor designed, manufactured or intended for use or resale as on line control equipment in hazardous environments
requiring fail — safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life
support machines or weapons systems in which the failure of the product could lead directly to death, personal injury or severe physical or environmental
damage (‘High Risk Activities’). 4D Systems and its suppliers specifically disclaim any expressed or implied warranty of fitness for High Risk Activities.

Use of 4D Systems’ products and devices in 'High Risk Activities' and in any other application is entirely at the buyer’s risk, and the buyer agrees to defend,
indemnify and hold harmless 4D Systems from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or
otherwise, under any 4D Systems intellectual property rights.
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